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Introduction

The Online Marketing Suite Cookbook contains instructions for marketers and content
authors working with Sitecore Analytics. This guide contains step by step instructions on
the key tasks necessary in setting up and configuring Sitecore Analytics on your website.

All of the examples in this cookbook use the Office Core website. This website is
designed to highlight the functionality available in the Online Marketing Suite.

This cookbook contains the following chapters:

e Chapter 1 — Introduction
This chapter is a description of the content, aims, and the intended audience of this
cookbook.

e Chapter 2 — Creating and Configuring Analytics
This chapter provides step by step instructions on how to create profiles, goals,
campaigns, multivariate tests, and personalization. It also includes instructions on
configuring these items in the Page Editor.

e Chapter 3— Assigning Analytics Values to Content Items
This chapter provides step by step instructions on how to assign profile values to content
items, how to associate goals and campaigns with content items, and how to assign
events, failures, and settings.

e Chapter 4 — Analytics Reporting
This chapter provides information about the Sitecore standard reports as well as how to
filter reports.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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Page 4 of 58



Sitecore OMS 1 Online Marketing Suite Cookbook @ sitecore

Creating and Configuring Analytics

This chapter provides step by step instructions on how to create and configure analytics
items in the Online Marketing Suite, Marketing Center.

This chapter contains the following sections:
e Content Profiling
e Creating Goals
e Creating Campaigns
e Testing

e Personalization

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.
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2.1 Content Profiling

Content profiles enable you to gain a better understanding of the behavior and actions of your website
visitors.

Marketers create content profiles and profile keys in the Marketing Center and content authors use the
Content Editor to assign values the contents of each web page.

When visitors come to your website they accumulate a profile score for each visit. This profile is based on
the values assigned to the content that they view and is recorded in the session trail.

Profiles

Creating profiles and profile keys enables you to categorize the content on your website. So when visitors
navigate through your site they accumulate a score that gives you an insight into the kind of content that
they are interested in.

Profile scores can be viewed as a bar chart in the session trail. This information helps content authors to
identify areas for improvement on the site. It can also be used for segmenting site visitors and to create
rules for personalization.

Scores

Scores give you an insight into a visitor’s level of interest in a website. For example, assigning a high lead
score to an item, such as a brochure download page means that if a visitor views this page they have
demonstrated a high level of interest in buying, so can be targeted as a potential sales lead.

This information can be particularly useful to sales teams. For instance, lead scores can give an
indication of future customers and sales.

Examples of scores:

Score Example

Lead Pages related to price carry a high lead score on your website.
Knowing which visitors achieve a high lead score could help a
sales team to target potential new customers.

Investor A visitor has viewed the annual report page on your site.
Assigning this page a high investor score could indicate which
visitors are interested in investment.

Big spender Assigning a high score to page that records the total purchase
amount of visitors on your site could indicate which visitors are
the biggest spenders.

The Office Core website is configured to record Lead scores to demonstrate this concept. The deeper a
visitor navigates into the site, the higher their lead score. There are some exceptions to this rule, such as
downloading a brochure which carries a higher lead score. In Sitecore Analytics, the lead reports are
stored under the Sales node and the lead scores of each visitor are shown in the session trail.

2.1.1 Pre-requisites
Before you assign profile values to content items you should consider creating:

o Website personas

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
this document are the property of Sitecore. Copyright © 2001-2010 Sitecore. All rights reserved.
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e A profiling strategy

e A scoring strategy

2.1.2  Creating Profiles

To create a new profile:

@ sitecore

1. Click the Sitecore menu and then click Marketing Center.

2. Inthe Marketing Center, click Profiles.

3. Inthe Home tab, in the Insert group, click Profile to create a new profile definition item.

Publish  Versions  Configure

) 9 Marketing Center Create a New Item.

{3 Fersonalization Frofile
& Profiles

a TestLab Items in the Folder

P coals
.
3 B Campaions @ A sitecore — ‘Webpage Dialog

Enter the name of the new item:

7 Analytics Fiters @ coms |Focus]

& v

4. Give the profile a name, such as, Focus.

5. In the Profile item, enter the appropriate field values.

Publish

Versions

Mavigate ~ Review  Analyze

= ) Marketing Center

¥ Goals
B Campaigns © Quick Info
H Personalization
B & Profies e
& Fous Name [shared]:
&) Function Focus
) Persona
&) Score

& TestLab
¥ Analytics Fiters

Field Value

Name The name of the profile, such as, Focus.
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Field Value

Type Select one of the following methods of calculation:
e Average

e Percentage

e Sum

This determines how profile values are calculated.

6. Inthe Home tab, click Save.

Click the Publish tab and then in the Publish group click Publish, Publish Item to publish the

new profile.
8. In the publishing wizard, select the Smart Publish option

2.1.3  Creating Profile Keys
To create a new profile key:
1. Inthe Marketing Center, select a profile such as Focus.
2. Inthe Insert group, click Profile Key to create a new profile key definition item.
Each profile can have any number of profile keys.

3. Give the profile key a name, such as, Background.

O = A b

I l W &) Frofile key (1ef2) ED () Copy To. u ]ﬁ p cut || [T Rename
save || Edit~ || L) insert from Template 252 < || Duplicate (2 MoveTo Delete - || paste L) Copy || ‘I Display Name
= || Edit Operations Clipboard Rename

A RFst
% ponn § Last
Sorting =

[search @ -] [ @ content
= %) Marketing Center e Focus
¥ Goals
B campaigns O quick Info
i
i Personalization £} ot 2 Sitecore -- Webpage Dialog
= & Profiles
B roas Name [shared]: Enter the name of the new item:
& Function Focus
Background
&) Persona | g |
[shared]:
& TestLab Sum
¥ Analytics Filters
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4. Inthe new Background item, enter field values.

= L) Marketing Center
& }" Goals
® B Campaigns

@ Background

s o D quick Info
& m;PElsDnallzatlUn =
= :,h Profies d bata
= A’_-,JyFocus Name =
é’ Backoround Background
&) Practical
j:;’ Process Control
:.h Scope Slider
= .i-,Jg) Function
+ 5‘1)9 Fersona MinValue
& :,h Score
E 8 Testlab
# S Analytics Fiters e
10
Field Value
Name A name for the profile key, such as, Background.
Control Select the type of control to appear in the Profiles dialog box:
e Checkbox
e Slider
e Smileys
e Stars
e Text
MinValue Enter a numeric value, such as, 1.
This field can also be left blank.
MaxValue Enter a numeric value, such, as 10.

In the Content Editor ribbon, click Save.

Publish the new item. In the publishing wizard, select the Smart Publish option.

Note

In the Sitecore Analytics training website there are four pre-configured profiles. Each profile has
its own set of profile keys. You can extend or delete these profile keys as appropriate for your

site.

You can create any number of profiles and profile keys but it is worthwhile planning a profiling
strategy before you start creating profile definition items.
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2.2 Creating Goals

@ sitecore

Creating goals and campaigns enables you to measure the success of your website.

Examples of goals:
e Download a brochure
e Register for an e-mail newsletter

e Sign up for an online demo

Once you have created some goals you can measure the conversion rate for each goal (the percentage
of visitors that achieve a particular goal). The website performance reports show goals and conversion

rates.

To create a new goal:
1. Click the Sitecore button and then click the Marketing Center.
2. Inthe Marketing Center, click Goals.

3. Inthe Home tab, Insert group, click Goal to create a new goal definition item.

Navigate  Review  And Publish  Versions  Co Presentaion  Scauity  View My Toobar

Name

Ih S, 2l
Duplicate (22 Move To Delete - || Paste  LH Copy || ' Display
i Clipboard Rename

(= ) Marketing Centsr Create a New Tten.

| Goals

[P Campaigns iﬁ
{3 Personalization Goal
&) Profiles
B Testlab

¥ Analytics Filters @ Architectural Digest Offer

Ttems in the Folder 7 Sitecore - Webpage Dialog

Enter the name of the new item:

|Reg|5ter|

4. Give the goal a name, such as, Register.
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5. In the new goal definition item, enter the appropriate values.

g \j-jr}vl’a\zzzilgCEmew @ Register
i 2O | @ ke
& 1nstant Demo [Efuers
& Login Name
() Newsletter Signup Register
& Register
# B Campaigns Openicon * Clear
= [ personzlization Icon
® 1 Profiles Business/16x16/address_book.png
® & Testlab
® % Analytics Filters Description
User has registered
TsSystem
IsAuthorfeedback
IsGoal
IsFailure
Field Value
Name Enter a name of your goal, such as, Register
Icon Select an icon for your goal.
Click Open icon and select an icon in the Open File dialog box.
To upload an icon of your own, click Upload in the Open File
dialog box.
Description Enter a suitable description, such as, User has registered.
IsSystem This defines the event as a system event.

For administrators and advanced users only.

IsAuthorFeedback | Select this checkbox to provide the content author with feedback
on goals.

IsGoal Select this checkbox to ensure that the goal appears in the Content
Editor, Goals dialog box. You can then associate the goal with a
content item.

IsFailure Select this checkbox to define the event as a failure.
For administrators and advanced users only.

6. Click Save to save the new goal.

7. Publish the new goal item. In the publishing wizard, select the Smart Publish option.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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2.3 Creating Campaigns

A campaign is a promotion or advertising initiative designed to encourage people to come to a website
and perform desired actions.

Sitecore Analytics supports two types of campaigns:

e Online Campaigns

o Offline Campaigns
You can view reports that show which of your campaigns are the most successful. You can then improve
or drop unsuccessful campaigns and improve your ROI.

You create goals and campaigns in the Marketing Center. You associate goals and campaigns with
content items in the Content Editor.

To create a campaign:

1. Inthe Marketing Center, click Campaigns, and then in the Home tab, in the Insert group, click
Campaign.

2. Give your new campaign a hame, such as, Google AdWords Campaigns and click OK.

[D [ Copy To x Iﬁ < Cut Rename A R Fist
Duplicate @ MoveTo  Delete ~ || Paste @ Copy T Display Name || % Down ' Last
‘Operations Clipboard Rename Sorting

[search 9, -] ﬂFu\der\‘Cunt&nt

B ) Marketing Center Create a Hew Item.

‘ Haome A b

P coals pe
8 [ Campaigrs o P
B Architectural Digest Eolder Campaign
{8 personalization 2 Sitecore -- Webpage Dialog &|
&) Profiles Items in the Folder —
— Enter the name of the new item:
'3 TestLab ? Architectural Digest

Y’ Analytics Filters ‘Guugle AdWords Campaigns| ‘
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3. Inthe new campaign item, enter the appropriate values.

oW r}f::::;g center ? Google AdWords Campaigns
= B Campaigns .
°Qulckln|o
® B Architectural Digesf =
B o siztecarpurs| || 0%
® { rersonalization Title
£ @Proﬁles
® & Testlab
# ¢ Analytics Filters Type
Description
Cost
Now - Clear
StartDate
Now * Clear
EndDate
Hidden
(ud]
Data
Field Value
Title The title of the campaign.
Type The type of campaign — whether it is an online or offline campaign.
Description A longer description of your campaign.
Cost Monetary cost of the campaign.
For example, Google AdWords campaigns have a cost per click.
StartDate The start date for the campaign.
EndDate The end date for the campaign.
Hidden Whether or not the campaign should be shown in reports.
For example, you may not want to show campaigns that are
created automatically in your campaign reports.

4. Click Save to save the new campaign.

5. Publish the new campaign item. In the publishing wizard, select the Smart Publish option.

2.3.1  Creating Campaign Events

To create a campaign event:

1. Inthe Marketing Center, select a campaign item and then in the Home tab, in the Insert group,
click Campaign Event.

2. Give your new campaign event a name, such as Award Winning Campaign and click OK.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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3. Inthe new item, enter the appropriate field values.

= 5) Marketing Center D Award Wil‘lml‘lg Campaign
# ¥ cosls
= B Campaigns 0 Quick Info
E B Architectural Digest 3 o
= B Google AdWords Campaigns bata
[5) Award Winning Campaign Name
® {5 Personalization Award Winning Campaign
© & Profies
® & Testlab Campaign Link
& S Analytics Fiters sc_camp=E0EGATAQ2F5342F 1BCI0DABCCIETOAZ0
Field Value
Name The name of the campaign.

Campaign Link This field contains a campaign query string.

For example:
sc_camp=7F967B85B627472AABES3F5F3DA51421

Append the query to the link to your website provided on the
sponsored site. If the link already includes a query string, prefix the
provided text with an ampersand (&). If the link does not include an
existing query string, prefix the text with a question mark (?).

This ensures that site visits generated by this campaign are
recorded in the analytics system.

4. Click Save to save the campaign event.

5. Publish the new campaign event item. In the publishing wizard, select the Smart Publish option.
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2.4 Testing

Sitecore Analytics lets you dynamically test the content of your website to find out which web controls are
the most effective.

You can create multivariate tests to see which combinations of text and images work best with site
visitors. This can be particularly useful as a part of your strategy when setting goals and optimizing
campaigns.

The Sitecore Analytics MV Tests report gives you pre-configured statistics on your tests and includes data
on the number of conversions that result from each test.

2.4.1 Pre-requisites
Before you can create a multivariate test, you need:
e Two or more content items to use as test variables.

e A control to use as the data source for your test.

2.4.2  Creating Multivariate Tests

In the following example, you will create a multivariate test for a newsletter form. Visitors to your website
complete this type of form to register for an e-mail newsletter. In this multivariate test, you test three
different combinations of text and graphics to find out which is the most effective.

To create a multivariate test:
1. Click the Sitecore button, and then click Marketing Center.
2. Inthe Marketing Center, click Test Lab.

W My Toolbar

¥
Rename A Up
T Display Mame || % Down
Rename Sorting ™

figa

ig blish Versions gure Presentation
B Multivariate Test [h £ Copy To x ﬁ p Cut
D Insert from Template { uplicate @. Move To  pelete - || Paste @ Copy
152 perations Clipboard

W
[earch 9, ~] 'JJFDIdEr\Lacuntent
B %) Marketing Center Create a Hew Item.

P Goals

 conprirs @
8 personalization Multivariate
&) Profles Test

£, TestLab
¥ Analytics Fiters

Items in the Folder

@ Mewsletter Form

2 Sitecore — Webpage Dialog

Enter the name of the new item:

|Newsletter Form| |

3. Inthe Home tab, in the Insert group, click Multivariate Test to create a new multivariate test
definition item.
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4. Call your test Newsletter Form.

@ Multivariate Test Variable
[0} tnsert from Template

= ) Marketing Center
1 coals
B Campaigns

Newsletter Form

8 Personalization [+ Greey
&) Profies Elata ]
B & Testlab Title [shared]:
B Newsletter Form Newsletter Form
@ Big-Check
@ Medium-Arrow Description [shared]:
@ small-Red Newsletter Registration Form

=¥ Analytics Fiters
Test Strategy [shar=d):
‘ Sticky v

Random L

5. Inthe new test item, enter the appropriate field values.

Field Value
Title The title of the test, such as Newsletter Form.
Description A description of the test.
Test Strategy Select a test strategy:
e Random — the test variable changes for each page
request
e Sticky — the test variable changes for each visitor session
(recommended)

6. Click Save to save the new test.

2.4.3 Creating Multivariate Test Variables

Each multivariate test must have at least two test variables. Each variable represents an item of web
content that you want to test. These content items must be created already.

Create three test variables for the Newsletter Form test:

1. Inthe Marketing Center, select the Newsletter Form multivariate test that you created earlier.

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The contents of
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2. Inthe Home tab, in the Insert group, click Multivariate Test Variable to create a new test variable.

Publish

= ) Marketing Center
P coals

B Campaigns 0 Quick Info
8 pPersonalization

Newsletter Form

=] pata =
& Profiles
B & Testlab Title [shared]:

P Newsletter Form Newsletter Form

¥ Analytics Fiters
Description [shared]:
Newsletter Registration Form

Test Strategy [shar=d):
Sticky v |

A sitecore -- Webpage Dialog

Enter the name of the new item:

‘Elg—Check |

3. For this example, create the following three multivariate test variables:
o Big-Check
o Medium-Arrow
o Small-Red

i Insert fra te {1 0f 1) [sm w5 copyTo = a
el |

- || Duplicate [k MoveTo pelete - || paste () Copy || I Display
Edt | Insert o . Cipboard e

m Templal
a @ -] | @ econtent

& %) Marketing Center Big-Check

¥ Goals
B campaigns

Q
Save

i personalization (st
&) Profiles Elpats
B 8 Testlab Name [shzrec]:
& @ newsletter Form Big Text - Check Button
Big-Check
Medium-Arrow Data Source [shared):
Small-Red sitecore/content/Home/Standard-Items/Register-Form/Big-Check

57’ Anclytics Filters

4. For each variable enter the following field values:

Field Value
Name A suitable name for the test variable. For example, Big-Check.
Data Source A link to the content item that is the data source for this test

variable, for example:
sitecore/content/Home/Standard-Items/Register-
Form/Big-Check
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5. Click Save to save the test variable.
Repeat this procedure for each test variable.
Link each variable to one of the content items that you want to test.
7. Publish the new test variables. In the publishing wizard, select the Smart Publish option.

2.4.4  Configuring Multivariate Tests

To activate a multivariate test on your website, you must edit the layout properties of the page where you
want to place the test. You can do this in the Page Editor or in the Content Editor.

Configuring Multivariate Tests in the Page Editor
1. Inthe Sitecore Desktop, click Sitecore, and then click Page Editor.

2. Inthe Page Editor, navigate to the page that you want to place the test on. In this case, the
Home page.

Click the Toggle the ribbon button © to display the ribbon.

In the ribbon, click the View tab and in the Enable group, select the Designing check box to
enable the design functionality in the Page Editor.

5. Onthe Home page, select the Register for our Newsletter item to see the design options for this
item.

@

Home Advanced Experience View

=
‘ :O: [¥] Editing [F] Controls

Preview v Designing [ Navigation bar

Mode Enable Show

*2 Sitemap @ Print

T —

——
—

Office Core

interior design for business spaces

- Register Form

FOXK O- moe-

Register for our Hewsletter

b

Office design services for effective businesses

Office Core designs and canstructs physical business environments that improve workflow, reduce clutter, improve
productivity, and actively contribute to a positive company image and foster employee satisfaction.
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@ Sitecore

6. Click the Properties button ¥ to open the Properties dialog box for this control.

&  Control Properties -- Webpage Dialog

8 TestLab
Tests

TestLab
1@ Newsletter Form

Mone

E] Parameters

Additional Parameters

==
«@

m

r

OK Cancel

7. Inthe Properties window, scroll down to the Test Lab section, and select the Newsletter Form

test.
8. Click OK.
9. Inthe Page Editor, click Save.

Now when a visitor comes to the website, a register form control is displayed on the home page. The
same register form control is displayed for the entire duration of the browser session. When a visitor
closes the browser window, they end the session. When a visitor returns to start a new session, a

different register form variable is displayed.

This enables you to test each variable so you can find out which control is the most effective.

Sitecore Analytics contains an MV Test report that lets you evaluate your multivariate tests. This report

includes the following information:
e Summary data for each test.
e Percentage of session visits per test variable.

e Number of session visits per test variable.

e Percentage of session conversions per test variable.

e Number of session conversions per test variable.
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2.5 Personalization

Personalization allows you to deliver targeted content to specific site visitors. An appropriate time to
implement this is after segmentation has enabled you to identify the visitors that you most want to target.

You can create rules to show or hide content to site visitors based on their browsing behavior and
accumulated profile values.

You can make your site respond in real-time by showing or hiding content, adjusting the behavior of a
web control or by running a multivariate test.

2.5.1 Pre-requisites
Before you can create personalization rules you need the following components:
e Content items to use as the data source for the conditional renderings.

e A Web control or rendering item.

2.5.2 Creating Personalization Rules

In Sitecore Analytics, you can create rules to determine which content is shown to different site visitors.
This is called conditional rendering. You create conditional rendering rules in the Marketing Center.

To create a conditional rendering rule:
1. Open the Marketing Center.

2. Inthe content tree, click Personalization and then click Rules.

(] Folder 1 0f 3) | ED (% Copy To x .ﬁ < Cut
O Conditional Rendering Rule 129739 | = || pupiicate (o MoveTo  pelate - || Paste Copy
| Operatio | Cipboa
I @, ~ |[[ DFolder \{ @ content
B 58 Marketing Center Create a New Item.
¥ Goals - _
8 commairs o ©
P
& §@ personalization Folder Concitional
< Predefined Conditions RendTnng
O Rules Rl
&) Profiles Items in the Folder
8 estiab o | Persona Profiles
¥ Anslytics Filters \ 1 subitem 0 subitems

To create a new rule, in the Home tab, in the Insert group, click Conditional Rendering Rule.
Give the rule a name, for example, Show Brochure to Leads and then click Save.

In the new rule item, in the Name field, enter the name of the rule. This is the same name that will
appear in the Designer when you configure your rule.
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6. Inthe Rule field, click Edit Rule.

Publish ~ Versi

= i) Marketing Center
¥ coals
B Campaigns

O Show Brochure to Leads

& 5 rersonalization N i
) Predefined Conditions El=i
B (D) Rules Name:
) Persona Show Brochure to Leads
83 Profiles
O Show Brochure to Leads 7 EditRule
&) Profies ( Rule [shared]:
8 TestLab \_ Norules,

¥ analytics Filters

7. Inthe Rule Set Editor dialog box, select a condition and an action for your rule.

/A Sitecore — Webpage Dialog
=== Rule Set Editor

E Select the conditions and actions first. Then spedfy
the values in the description.

1, Select the conditions for the rule:

Conditions A
where the area code compares to specific value =
where the city compares to spedific city

where the country compares to spedific country

where the DNS address compares to specific value |
< i | &

2. Select the actions for the rule:

Actions ~
D hide rendering

O process multivariate tests
[ set data source to Item

D set parameters to value
= bt

3. Rule description (dlick an underlined value to editit):

R

Rules Example

This example demonstrates how to create a rule that determines when new site visitors will see the Office

Core brochure link.
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On the Office Core site, a brochure download link is displayed on every page, apart from the home page.
This rule will specify that the brochure link on the Our Services page is not displayed to new visitors
unless they attain a lead score of 20 or more.

1. Inthe Marketing Center, create a new rule called Hide for New Visitors.

2. Inthe Hide for New Visitors item, in the Rule field, click Edit Rule to open the Rule Set Editor
dialog box.

3. Inthe Rule Set Editor dialog box, in the Select the conditions for the rule section, scroll down
and select the following rule:

“Where the value of specific profile key compares to specific value”

This rule is now displayed in the Rule description section.

3. Rule description (click an underlined value to editit):

where the value of specific profile key compare:

Now you must edit the values in this condition so that only visitors who have accumulated a lead
score of 20 or more can see the brochure download link.

4. Inthe Rule description section, click “specific” to open the Select Profile Key dialog box.

A Sitecore - Webpage Dialog @

F Selact Profile Key
|_ Select the profile key to use in this

rule,

H @ Focus
= @ Function
+ @ Persona

= @ Score

5. Inthe Select Profile Key dialog box, expand Score and select Lead.

6. Inthe Rule Set Editor dialog box, in the Rule description section, click “compares to”, to select
a comparison to use in this rule.
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7. Inthe Select Comparison dialog box, select “is less than or equal to” and click OK.
& Sitecore -- Webpage Dialog |z|
r Select Comparison
Select the numerical comparison to use
in this rule.
s equal to
[ i areater than
- is greater than or equal to
[ is less than
2
[ is not equal to
[ OK ] [ Cancel
8.

In the Rule Set Editor dialog box, in the Rule description section, click “specific value”, to enter
a numerical value.

In this example, you want the brochure download link to be displayed on the Our Services page
when the Lead profile score is higher than 20.

Enter “20” and click OK.

A Sitecore -- Webpage Dialog E|

== Rule Set Editor
E Select the conditions and actions first, Then spedfy the values in the
description.

1. Select the conditions for the rule:

Conditions A

where the area code compares to specific value
where the city compares to specific ity

where the country compares to specific country
where the DNS address compares to specific value
where the visit no. compares to number

where the IP address compares to spedfic value
where the ISP name compares to specific value

A Sitecore - Webpage Dialog

Enter value
o |

< | &
3. Rule description (dick an underlined value to edit it}

where the value of Lead profile key iz less than or eaulyl tospecific valus *
hide rendering

9. Inthe Rule Set Editor dialog box, in the Select the actions for the rule section, select one of

the pre-configured actions for your rule.
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In this example, select “hide rendering”.

WRErE SPECITIC IS0 COMPAres 0 SPeanc value

2. Select the actions for the rule:
Actions 5
hide rendering
[ process multivariate tests

[ set data source to Item
[ set parameters to value
[ set placeholder to value

Common

D run spedfic script

10. In the Rule Set Editor, click OK to save the rule.

11. In the Marketing Center, click Save and then publish the new rule. In the publishing wizard,
select the Smart Publish option.

2.5.3 Configuring Personalization Rules

To activate a personalization rule on your website, you must edit the layout properties of the page you
want to personalize. There are two ways to do this.

¢ Inthe Content Editor, use the Presentation tab, Layout Details dialog box.

e Inthe Page Editor, use the Designing mode.

Configuring Personalization Rules in the Page Editor
1. Inthe Sitecore Desktop, click Sitecore and then click Page Editor.
2. Inthe Page Editor, navigate to the page that you want to edit.
In this example, edit the Our Services page.

3. Inthe ribbon, click the View tab and in the Enable group, select the Designing check box to
enable to the design functionality in the Page Editor.
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4. Select the Brochure Links control and click Properties ¥ to open the Properties dialog box.
A

ch our services to the specific needs of our
>m basic design consultation to full turnkey
ment and furnishing.

Architectural Digest Special
Offer

It is true! Office Core is THE
featured firm in the most recent
issue of Architectural Digest. So,

celebrate with us! Ge ahead and

Brochure Links ay!

@~ voe~

Want more information?

Have z look at our brochuras!

ood relationship with an architect or
ice Core can bring new expertise to the
w, IT infrastructure, acoustics, and
-equire specialized expertise.

T
o]

read more

5. Inthe Properties window, scroll down to the Personalization section.

Control Properties - Mozilla Firefox ==
(& ]
. ~-a
i Personalization =
ion [shared]:

Persona

[Cwvisitor Is Human

Rules

[V Hide for New Visitors

6. Select the rule you created called — Hide for New Visitors.
7. Click OK to close the Properties window.

8. Inthe Page Editor, click Save.

Testing the Rule
To test that the rule works:
1. In anew browser window, open the Office Core website.

2. Navigate to the Our Services page.
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Notice that there is no longer a brochure displayed in the right-hand column.
3. Explore the site a little more and return to the Our Services page.

Once you have accumulated a lead score of 20 or more, the brochure link will appear in the right-
hand column.
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Assigning Analytics Values to Content Items

This chapter tells you how to assign profile values and scores to content items using the
Content Editor or the Page Editor. It also explains how to associate Sitecore Analytics
items with content items.

e Assigning Values to Profiles and Scores

e Associating Goals with Items

e Associating Campaigns with Content Items
e Assigning Events to Items

e Assigning Failure Actions to Items

e Page Settings
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3.1 Assigning Values to Profiles and Scores

Once you have created a set of profiles and profile keys you can start to assign values to content items
on your website. You assign values to profile keys in the Content Editor or Page Editor.

3.1.1 Assigning Profile Values to Content Items in the Page Editor
1. Open the Page Editor and in the Office Core website, navigate to Our Services.

2. Inthe Page Editor, Advanced tab, Analyze group, click Profiles to open the Profiles dialog
box.

Home  Advanced — Experience  View

=
=
@i (e]lnz

Preview « Profiles Details Reset

Made Analyze Layout

Office Cor

interior design for business spaces

Home Our Process Our Services

3. Inthe Profiles dialog box, select the Focus check box and move the slider controls to assign
values to each profile key.

A Sitecore — ‘Webpage Dialog

Profiles
Select the content profile values that best describe the content on this page. Content
profile values help build a picture of the visitor's interests as they navigate through your
~\
A
’/ Focus: \'
Background:
1
Practical:
10
Process:
3
Scope:
\ 8 /
[ Function:
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You have now assigned values to the Focus profile.

4. Repeat this procedure for each profile key.

Note
Profile key values can be left blank if they are unsuitable for a content item.

5. When you have finished assigning values to profile keys, click OK to close the Profiles dialog
box and to save your changes.

Note

If you do not select the check box next to a profile key first before editing it, the values are not
saved.

3.1.2 Assigning Scores

You also use the Profiles dialog box to assign scores to content items in the same was as you assign
profile values to content items.

A Sitecore - Webpage Dialog

Profiles

Select the content profile values that best describe the content on this page. Content
profile values help build 3 picture of the visitor's interests as they navigate through
your Web site.

Ian: A,

Sandra:

o

Score:
Lead:

~ <l

oK Cancel

3.1.3 Assigning Profile Values to Content Items in the Content Editor
You can also use the Content Editor to assign profile values to content items.
To assign profile values to content items in the Content Editor:

1. Inthe Content Editor, expand the content tree and locate the item that you want to assign profile
values to.
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2. Inthe Analyze tab, in the Attributes group, click Profiles to open the Profiles dialog box.

‘ o Analyze b
B o ¥ 9 &g
Save || Profiles | Goals Attributes || Detale || Reports
Attributes View Behavior
[search @, =] [ W centent
= .
& conters Our-Services
= &) Home
[+ 4
# ) Standard-Items @ Quick 1nfo
(@ Our-Process & ba
- nner
ﬂ Qur-Services
& our-Clients Banner Slogan:

3. Inthe Profiles dialog box, repeat the procedure described in the previous section.
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3.2 Associating Goals with Items
After you create a goal in the Marketing Center, you must associate the goal with a content item.

When a visitor navigates to a page that has a goal assigned to it, a conversion is recorded in Sitecore
Analytics.

In this example, you assign the Register goal to the Home item.
How to associate a goal to a content item:

1. Open the Content Editor.

2. Navigate to the Home item.

3. Click the Analyze tab and then in the Attributes group, click Goals.

‘ o Aanalyze b o o ti 0 = oolb

'.}ﬁ 3 () r
£ & a
Save (| Profileq Goals |JAttributes (| Details || Reports A Sitecore -- Webpage Dialog
e || Attribute View Behavior i Goals
~]

| Search Q, Content % 'i Select the goal that is achieved when a visitor accesses this

page. When a visitor completes a goal, this action is called 2

= ol Content Home conversion.
&
The start page S ——
& standard-Ttems D?\rchitectural Digest Offer;

@ Qur-Process o Ly [Brochures Request
a Qur-Services «f Banner [ 1nstant Dema
&3 our-Clients Banner Slogan:
€ Cur-Partners Dliegn
‘¢ Design-Inspiration [Ohewsletter signup
& News-and-Events Register
& About-Us
[ contact-Us
{J Meta Data Browse * Propertie:
‘Jj Settings Banner Image:

4. Inthe Goals dialog box, select the Register goal.
5. Click OK to save your changes.

You have now assigned the Register goal to the Home item.
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3.3 Associating Campaigns with Content Iltems

After creating a campaign in the Marketing Center, you must ensure that the campaign is triggered in
Sitecore Analytics so you can track which campaigns your site visitors have come from.

Online Campaigns

An online campaign consists of a campaign definition item and a campaign event. To associate an online
campaign with a content item, you must copy the campaign query string to the sponsored site and if
necessary edit the query string to point to a page on your website.

How to associate an online campaign with a content item:
1. Open the Marketing Center.
2. Expand the Campaigns node and then click the Google AdWords Award Winning Campaign.

- ;f';:::;g Center D Google Adwords Award Winning Campaign
= B campaigns © Quick Info +
= Google Advords -
[£] Google Adwords Award Winning Campaign Elpata =
= i Personalization Name :
# ) Profiles
# ) Testlab
E % Analytics Filters Campaign Link

sc_camp=ETCABTID1171406E5321E9EI511A2CFT

In the Campaign Link field, copy the query string.
Paste the query string to your sponsored site.
This example uses a Google AdWords campaign.

5. Paste the campaign query string into your sponsored site.

Award-winning Web CMS Award-winning Web CMS
Enterprise-class. 1600+ customers

Leading Choice for Marketers and IT
www_sitecore_net Leading Choice for Marketers and T

Enterprise-class, 1600+ customers

Pidefaut aspx?sc_camp-be4crasazesy |

Save || Cancel

I http:)

You must append the query string to your site URL. In this example the website URL is:
www.sitecore.net/default.aspx

The query string provided for this campaign is:
sc_camp=EOE6A1AQ02F5342F1BC30DABCC3670A20

After you insert the query string, you must insert a question mark to complete the path, as this is
not included in the Campaign Link field:

www.Sitecore.net/default. ascamp=EOE6A1AO2F5342F1BC3ODABCC367OA2O
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6. By default the campaign query string links to your home page. To point to a different page, you
must edit the query string. For example, you could replace /default.aspx? with /Our-
Services.aspx?

E http:dl ™ Iwww sitecore.net/defauh‘aspx’sc_cal

Save | Cancel | '

When a visitor comes to your website from this campaign, a campaign event is triggered in Sitecore
Analytics, and this is recorded in the Latest Human Sessions report.

Offline Campaigns

An offline campaign consists of a campaign definition item, a campaign event, and a landing page that
can be reached using an alias.

To activate an offline campaign, you use the Content Editor to associate the campaign event with a
landing page. In this example, you associate the AD08 campaign with the Architectural-Digest-May-08
landing page.

To associate an offline campaign with a landing page:
1. Open the Content Editor.

2. Inthe Content Editor content tree, navigate to the Standard-ltems folder. Open the Landing-
Pages folder and then select the Architectural-Digest-May08 content item.

3. Inthe Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog box.

Analyze Publish Vi Configure Presentation

L
Attributes || Details || Rey
Q,

Profiles  Goalg|
¢ /) Attributes
.

tributs
W/ Select the analytics attributes that are assodated with this page. -
= & Content Analytics atiributes help build a more comprehensive picture of the
visitor's behavior =5 they navigate through your Web site,
= &) Home

& ) standard-Items Campaigns | Events | Faiure Actions | Settings

2 Brochures
m Copyright
& ) Landing-Pages

) Architectural-Digest-May08

T HEgeter Torm

? Select the associated campaigns.

[
Google AdWords Campaigns

[ award Winning Campaign

=\ search-Results
. Statistics
) Teasers
i{J Toolbox
@?Our—Pmcess
£ our-Services
83 ourClients
€ Our-Partners
@ Design-Inspiration
= &P News-and-Events H

4. Inthe Attributes dialog box, select the AD08 campaign.
5. Click OK.

Now when visitors come to your site from this campaign, a campaign event is triggered and this is
recorded in the Latest Human Sessions report in Sitecore Analytics.
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3.4 Assigning Events to Items

Events are used to track user activity on a website. They help to build up a more comprehensive picture
of a visitor’s behavior as they navigate through the website.

Goal and campaign events are triggered when visitors achieve certain objectives on the website or when
they come to a site from a promotion or campaign that you have created. These events are tracked in
Sitecore Analytics and appear in the campaign and conversion tracking reports.

You can also associate other events with content items. You can track events, such as, download,
search, registration or logout. Sitecore administrators can create additional events if needed.

To assign an event to a content item:

1. Inthe Content Editor, expand the content tree and navigate to the content item that you want to
assign an event to.

In the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog box.

3. Inthe Attributes dialog box, click the Events tab, and select the event that you want to assign to
the content item.

tation View

|28 ST RO 2 sitecore — Webpage Dialog
Atributes [§ Details

Select the analytics attributes that are assodiated with this page. -

= Binalytics attributes help buld 2 more comprehensive picture of the
— D wisitor’s behavior as they navigate through your Web site. —
B sitecore
E & Content Campaigns Events Failure Actions | Settings
& € Home 99 select the associated events. it it.
& ) Standard-Ttems
~ Brochures Dcampa\gn
m Copyright o
) Landing-Pages Donriozd
B ) Register-Farm Derror
Big-Check [Field Changed
7] Form-Settir
ormserings Dinformation
Smal Red
2\ Thank-You [ Login Failed
) Title-Styles [Diogout
2 Search-Results [CInensletter Removed
> Statistics
- Opal
L Teasers
€ Toolbox Oeene =
@ Our-Process [Iputin Basket
£ our-Services Orate
& our-Clients DR ter Failed
egister Faile
& Our-Partners < .
o Design-Inspiration g
¥ News-and-Events
& About-Us [search
[ contact-Us
OvetsData [Cupdate Profie
{2 Settings
[&8] Media Library

4. Click OK to save your changes and close the Attributes dialog box.
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3.5

Assigning Failure Actions to Items

Failure actions are another type of event. Normally page failures are recorded programmatically. You can,
however, use failure actions to record any page failures that occur on the website in Sitecore Analytics.

@ Sitecore

For example, if you have an error page that you display to site visitors when an error occurs, you can
associate a failure action such as Page Error with this page. Then when a visitor sees this page, a page
error is recorded in Sitecore Analytics and you can track all the page errors that occur on your site in this

way.

To assign a failure action to a content item:

1.

4. Click OK to save your changes and close the Attributes dialog box.

In the Content Editor, expand the content tree, and navigate to the content item that you want to

assign a failure action to.

In the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog box.

In the Attributes dialog box, click the Failure Actions tab, and select the event that you want to

assign to a content item.

S| o [l
Profiles  Goals | Attributes || Details || Reports
Attributs v —

o Home MNavigate  Review [EGDeBl FPublich

=] D sitecore
= & content
B &) Home
B stendard-Ttems
- Brochures
[l copyright
& Landing-Pages
) AD-Signup-Complete
) architectural-Digest-May08
i) RegisterFarm
. Search-Results
. Statistics
{{J Teasers
{{J Tookox
@ our-Process
8 our-Services
& Our-Clients
& Our-Partners
 Design-Inspiration
& MNews-and-Events
@B About-Us
|2 contact-Us
{2 Meta-Data
) settings

Versions Presentation View My Toolbar

I Attributes
Select the analytics attributes that are associated with this
page. Analytics attributes help build a more comprehensive
picure of the visitor’s behavior a3 they navigate through
your Web site.

Campaigns Events Failure Actions Settings

) seizct e sscocisted fure sctine,

[¥I€ampaion Fegistration Faied
o Search Hits Found

O Page Error

[ Page Mot Found

A Sitecore - Webpage Dialog &‘
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3.6 Page Settings

You can also disable analytics on any content item on your website by choosing the Disable Analytics for
this Page toggle on the Settings tab. Once you have applied this setting, the page is no longer visible in
the visitor session trail or any other reports in Sitecore Analytics.

This is useful if you, for example, have a page that automatically redirects visitors to another page. You
may not want such a page to appear in reports and session trails.

To assign a setting to a content item:

1. Inthe Content Editor, expand the content tree, and navigate to the content item that you want to
keep out of the reports.

In the Analyze tab, in the Attributes group, click Attributes to open the Attributes dialog box.

3. Inthe Attributes dialog box, click the Settings tab and select Disable Analytics for this Page to
assign this setting to the content item.

N
Profiles  Goals | Attributes

Attribute

[UEEl Pubish  Versions  Presentaon  View My Toolbar

v Behavio

ard Q-] [ @ econtent
B (5 sitecore

= & Content Sitecore - Webpage Dialog

B ) Home [ Attributes -

{3 Standard-Ttems _)-,;) Select the analytics attributes that are associated with this page. '
Analytics attributes help build 3 more comprehensive picture of the
d Qur-Process wisitor s behavior as they navigate through your Web site.
ﬂ Our-5ervices
&2 our-Clents Campaigns | Events | Failure Actions Settings
P Our-Partners Selact the appropriate settings.
= @ Design-Inspiration
-\ Traditional

[¥lSiable Analytics for this Page:
“\ Sustainable
2\ Functional 1F you disable analytics for this page, Sitecore wil not register information
- " when visitars access this page.
L Fantastic
& News-and-Events
3 About-Us
[ contact-Us
i) Meta-Data
{2 Settings
[&5] Media Library

4. Click OK to save your changes and close the Attributes dialog box.
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Analytics Reporting

This chapter describes the Sitecore Analytics reporting system that lets you present,
analyze, and refine all of the statistics collected by the Online Marketing Suite.

This chapter includes instructions on:
e Running Sitecore Analytics Reports
e Viewing the Session Trall
e Classifying Site Visitors
e Subscribing to Reports
e Linking to CRM

e Saving and Filtering Reports
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4.1 Running Sitecore Analytics Reports

Sitecore Analytics contains a number of standard reports that you can run out of the box. These reports
are grouped in the following categories:

= 4P Reports
) Marketing
& sales
3 site Health
(&) Recent Activity

Marketing
Campaigns, Goals, Site Metrics, MV Tests

Sales
Lead reports or other score information

Site Health
Slow pages, not found URLs

Recent Activity
Latest Human and Robot Sessions

To open a Sitecore Analytics report:
1. Inthe Sitecore Desktop, click the Sitecore button and then click Sitecore Analytics.

2. In Sitecore Analytics, click the node you want to expand, such as Recent Activity, and then click
the Latest Human Sessions report.

The report is displayed in the right-hand panel of the Sitecore Analytics window.

7 sitecore Analytics —
B 4 Reports I
f) Marketing
& sales
[§) site Hesith Latest Human SESSIOHS

& @) Recent Activity
8 Latest Human Sessions
@ LatestRabot Sessions

2009-08-2407:44:06  Hi3G Access AB
Copenhagen, DK, 06 - (Hi3G Access AB)
1 page viewed, spent 00:00:16
Lovisit
aafarred from (direct)
158 / subscribe / CRM

2009-08-2407:34:27  Canon NL
Den Haag, ML, 11 - (XS4ALL Internet BY)
3 pages viewed, spent 00:24:30
2. visit
Rreferred from (direct)
Competitor / Subscribe / CRM

2009-08-2407:32:17 Amazon Inc.
Dallas, US, TX - [SBC Internet Services)
1 page viewed, spent 00:00:00
12 visit

Referred from wiww.google.com - "Best camera”
Business Partner / Subscribe / CRM

2009-08-2407:25:03  Canon NL
Den Haag, NL, 11 - (X34ALL Internet 8Y)
50 pages viewed, spent 00:35:18
L. visit
feferred from [direct] - "price performance camera”
Competitor / Subscribe / CRM
Conversion: Product finder Select product

Conversion: Contact Form submitted

Conversicn: Review

Conversion: Rate Page

Conversion: Upload photos

Conversion: Product finder Select product

Conversion: Upload photos

Conversion: Login [

Q sitecore R Sitecore Analytics E
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Marketing

@ Sitecore

The following table summarizes the reports you can find under the Marketing node:

Marketing Reports

Description

Campaigns

Lists all the campaigns.

Campaign Details

Lists all the campaign definition items and campaign
events.
Displays statistics on:

e  Number of visits.

e Goal conversion rates.

e Profile scores.

Campaign Summary

Lists all the campaign definition items.
Displays statistics on:

e Number of visits.

e Goal conversion rates.

e Profile scores.

Conversion and Profile
Tracking

Displays the total goals achieved by all site visitors.

Tracking — First Time Visitors

Displays the goals achieved by first time visitors.

Tracking — Returning Visitors

Displays the goals achieved by returning visitors.

Downloads Displays a list of all the items that have been downloaded
with the most recent first.
Metrics Displays the total visits, total page views and the average

page views per visit for the website.
Graphs illustrate the number of visitors and the number of
page views.

Metrics New Visitors

For new visitors this report displays:

e Total visits.

e Total page views.

e Average page views per visit.
Graphs illustrate the number of visitors and the number of
page views.

Metrics Returning Visitors

For returning visitors, this report displays:

e Total visits.

e Total page views.

e Average page views per visit.
Graphs illustrate the number of visitors and the number of
page views.

MV Tests For each MV Test, you can view:
e Percentage of session visits per test variable.
¢ Number of session visits per test variable.
e Percentage of session conversions per test
variable.
¢ Number of session conversions per test variable.
Site Search Lists all the searches made on the website.
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Marketing Reports

@ Sitecore

Description

Top Exit Pages

Lists the most popular pages viewed before visitors leave
the website.

Top External Search
Keywords

Lists the top words used in search engines such as
Google, Yahoo and Live Search that led the visitor to your
website.

Top Landing Pages

Visitor entry point. This report displays a list of all the web
pages that were viewed first on the website.

Top Pages

The most viewed pages on the web site ranked in order of
popularity.

Top Traffic Pages

A list of the websites that visitors have come from. For

example Google.com, if a visitor found the site from a
Google search.

Sales

You can configure the sales area to display your own reports. For example, if you decide to record lead
scores, you can display lead reports for your sales team.

It is possible to identify competitors here. Analyst and press reports are constructed in a similar way to
competitor reports.

Your site administrator can help you to configure reports for this area.
Site Health

Site Health contains reports on any failures that occur on your website. Site Health Reports can help you
identify potential problems with your website or on your web servers. This is useful information that could
highlight potential problem areas that require further investigation.

Expand the Site Health node to view all the available reports:

N
3 o Reports jul 13 - jul 20, 2009 Fiter Save Filter Design z
) Marketing
¥ S Print | Save I4 4 Page of1 b bl Q) w00% [, Whole
= (@ site Health
Common Mistakes
(i Latest Failures
0 Mot Found Urls .
Pagas that Report Errors LateSt Fa]lures
3 Slow Pages 2009-07-14 10:40:20 Page Not Found
# (¥) Recent Activity fsitecore/service/notfound aspx?item=%2fitecorefus
The page '/itecore’ was not found
~
< > < >
Site Health Reports Description

List the most common mistakes that occur on the web site,
such as, no search hits found, user subscription failed, login
failed, and so on.

Common Mistakes
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Site Health Reports Description

Latest Failures Lists all the latest failures on the web site, for example, if a
visitor had difficulty logging in or if a visitor performed a local
search that gave 0 results.

Not Found URLs Lists all the URLs that were not found.

If a URL is listed as Direct, it means that the visitor typed the
address incorrectly into the browser. These are the most
common not found URLSs.

Pages that Report Errors Lists all the pages that report errors.
Slow Pages Lists all the pages that loaded slowly with the slowest listed
first.

Recent Activity

Recent activity reports record the latest visits to your website.

Recent Activity Reports Description

Latest Human Sessions Lists all the human visitor sessions to your website (including
active sessions), with the most recent listed first.

Latest Company Sessions List all company sessions, if the visitor has been classified as

a company.
Latest ISP Sessions List all ISP sessions, if the visitor has been classified as an
ISP.
Unidentified Sessions Lists all unidentified visitor sessions.
Latest Robot Sessions Lists all the latest robot sessions.
For example, web bots, malicious robots
Latest Auto Detected Lists all the robots that have been detected automatically.
Robots

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. Th
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4.2

Viewing the Session Trail

@ sitecore

Open the Latest Human Sessions report, to see a list of all the visits to your website, with the most recent

first:

= LJ‘ Reports
) Marketing
@ sales
[a Site Health
=] @ Recent Activity
& Latest Human Sessions
i Latest Robot Sessions

Latest Human Sessions

2009-08-24 08:57:56

2009-08-24 08:57:36

2009-08-24 08:34:35

Dell UK

London, GB, H2 - (MurphX Innovative Selutions)
1 page viewed, spent 00:03:20

2.visit

Referred from (direct) - "Best camera”

Business Partner / Subscribe / CRM

Dell UK

London, GB, H8 - (MurphX Innovative Solutions)
12 pages viewed, spent 00:05:32

1 visit

Referred from wuw.google.dk

Business Pariner / Subscribe / CRM

PopPhoto

2009-08-24 08:32:36

Milferd, US, NH - {Comeast Cakle)
19 pages viewed, spent 00:02:43
5 wisit

Referred from (direct) - "Nicam”
Press / Subscribe / CRM
Conversion: Lagin

PopPhoto

2009-08-24 08:25:30

Milferd, US, NH - [Comeast Cakle)
5 pages viewed, spent 00.01:35

4 wisit

Referred from (direct) - "Nicam”
Press / Subscribe / CRM

PopPhoto

2009-08-24 08:22:31

Wilford, US, NH - (Comeast Cable)
28 pages viewed, spent D0:06:52

3. wisit

Referred from (direct)
Press / Subscribe / CRM
Conversion: Subscribe community
Conversion: Upload photos
Conversion: Register

PopPhoto
Milford, US, NH - [Comcast Cable)
30 pages viewed, spent 00:02:38
2. visit

Referred from (direct) - "Nicam"
Press / Subscribe / CRM
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Click the date stamp of an individual session to open the Session report and see the details of that
session:

Name:  PopPhoto Classified as Press
2000-08-2408:57:56  Dell UK Countr: U—SL EEre—
London, GB, HE - (MurphX Innovative solutions) (iw: Milford = o
viewed, spent 00:03:20 Reg'mtn\:: NH =
Referred from (direct] - "Best camera” I5P:  Comcast Cable
Business Partner / Subscribe / CRM Referrer:  (direct) - "Nicam”
2009-08-2408:57:36  Dell UK Dateftime:  2009-08-2408:34:35
London, G8, HS - {MurphX Innovative Solutions| Visitno.: &

ewed, spent 00:05:32

Page Count: 19

. Duration: 00:02:43
Referred from www google.dk
isiness Partner / Subscribe [ CAM

Function: 25

2009-08-24 08:34:35 'opPhoto
ford, US, NH - (Comcast Cable) 29
s viewed, spent 00:02:43 154
from (direct) - "Nicam” .4
scribe / CRM
on: Login 0.5 4
2009-08-2408:32:36  PopPhoto i
Milford, US, NH - (Comcast Cable)
5 pages viewed, spent 00:01:35 Building Trust
from [direct] - "Nicam" 00:00:00  /default.aspx
Press scribe / CRM Triggered campaign 1ec2a50e-h7cf-47fh-84e3-6d4f1eca776f [Event: Campaign]
2009-08-2408:25:30  PopPhoto oo:co.0e  [enfProducts/Find the
Milfard, US, NH - (Comcast Cable) Right Nicam.aspx
cwed, spent 00:06:52 Product Finder used [Event: Product Finder used ]
. ‘ 00:00:29 [en.aspx
red fom direet) Username: "extranet\id" [Goal: Login]
?m’frs on Su\:s(rEcmmun ity 00:00:46 jen/Community.aspx
Conversion: Upload photes .
Conversion: Register 00:00:51  fen/My_Micam.aspx
2009-08-2408:22:31 PopPhota 00:00:56
Milford, US, NH - (Comcast Cable)
?C | ges viewed, spent 00:02:38 00:00:56
?msd from (direct) - "Nicam” ) N
Press / Subscribe / CRM 0o:01:42 LeniCemmun -,
Press LeM album aspx
ooonas  [en/Community/wildlife
Community
Ty
The Session report shows all the details of this site visit:
Session Report Details Description
Name Visitor company or organization.
Country Visitor country of origin (based on IP address).
City Visitor city of origin.
Region Code specifying the region.
ISP Name of Internet Service Provider.
Referrer Web site where search originated, for example Google.com.
Date/time Date stamp of visit.
Visit no. Sequential visit number.
Page Count The number of pages viewed on the site during this visit.
Duration The length of time the visit lasted.
Profile values Bar charts displaying profile scores for each profile key.
Session trall All the web pages viewed during this site visit and hyperlinks that link
back to the actual web pages. Each URL is listed with a timing
associated with it.
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@ Sitecore

Click the name of a visitor to open the Sessions report and see a list of all their visits to your website

listed by date.

Latest Human Sessions

2003-08-24 08:57:56  Dell UK
Londen, GB, HS - (MurphX Innovative Solutions)
ed, spent 00:03:20

cribe / CBM

2009-08-2408:57:36  Dell UK
Lendon, GB, HS - (MurphX Innevative Selutions)
12 ewed, spent 00:05:32

dk
cribe / CAM

2009-08-24 08:34:§5
Comeast Cable)
wel spent 00:02:43

Referred from (

direct] - "Micam”
ke / CRM

2009-08-2408:32:36  PopPhoto
fi US, NH - (Comcast Cable)
| spent 000135

/ ERM

2009-08-2408:25:30  PopPhoto
Milford, US, NH - (Comcast Cable)
ewed, spent 00:06:52

Conversion: Uplaad photos
Conversion: Register

2009-08-2408:22:31  PopPhoto
Milford, Us, NH - (Comcast Czble)
30 pages d, spent 00:02:38

ect) - "Nicam”
ihe / CRM

Sessions

PopPhoto
Stratham, US, NH - Comcast Cable)

PopPhoto
Milford, US, NH - {Comcast Cable)

2009-aug: :34:35

(direct) - "Nicam

2009-aug: 1

ed,

Click on one of these sessions, to open the Session report and see detailed information about that

particular session.
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4.3 Classifying Site Visitors

Sitecore analytics lets you classify the visitors that come to your website. You can classify visitors as
coming from your own company, as competitors, as robots, and so on. These classifications can then be
used to filter your statistics thereby improving their quality, and ultimately to improve your visitor
segmentation.

We recommend that you classify site visitors early and often to make your site statistics more meaningful.
Classifying visitors benefits your organization, helps enable your sales force, and makes the task of
personalizing content easier.

To classify a site visitor:
1. Open Sitecore Analytics.
2. Expand Recent Activity and then click the Latest Human Sessions report.

3. Select a visitor session that is unclassified.

Sessions

N/A

Dallas, US, TX - (SBC Internct Services)

2009-aug-26 15:27:16
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4. Click Classify to open the Visitor Classification dialog box.

A Sitecore — Webpage Dialog
i Visitor Classification

Classify a visitor,

Unclassified
This visitor has not been dassified.
Business
IP_NOT_FOUND
=
7
Unclassified
This visitor has not been dassified.
1P Address
127.0,0.1
=
7
Unclassified
This visitor has not been dassified.

User Agent

i

Ma:

ompatible;
7 LR

ws NT 5.1; \NET CLR 1.1.4322; \NET CLR 2.0.50727; .NET CLR
JMET CLR 3.5.21022; .\NET CLR 3.0.4505.2152; .MET CLR 3.5.30729;

Unclassified
This visitor has not been dassified.
DNs

LTCBU.dk.sitecare.net
o

v
Unclassified
This visitor has not been dassified.

This Visitor

="

7
Unclassified
This visitor has not been dassified.

@ sitecore

5. Inthe Visitor Classification dialog box, use the sliders to select appropriate values.

In the Office Core website we have defined the following values:

Attribute

Description of values

Business, IP Address, DNS,
This Visitor

Select one of the following values:
Unclassified
Business Visitor

ISP

Existing Customer
Analyst

Press

Supplier

Business Partner
Competitor

My Company

Bot — Feed Reader
Bot — Search Engine
Bot — Unidentified
Bot — Auto-detected
Bot - Malicious
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Attribute

Description of values

User Agent

Select one of the following values:
Bot — Feed Reader

Bot — Search Engine

Bot — Unidentified

Bot — Auto-detected

Bot - Malicious

6. Click OK to save your changes.

Note

These attributes and values are taken from the Office Core website to illustrate the concept of

classification.

@ Sitecore
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4.4 Subscribing to Reports

You can subscribe to reports that are of special interest to you. For example, if you subscribe to a
report for a specific site visitor, you will be sent a report every time this visitor returns to your website.

To subscribe to a report:

1. Open Sitecore Analytics.

2. Open the report that you want to subscribe to.
3. Click Subscribe.

jul 10 - jul 17, 2009 Filter Save Filter Design

& print = 14 4 Page of2 b Pl Q 100%

Sessions

Sitecore already has your e-mail address as part of your Sitecore user information. When you
have subscribed to a report, Sitecore displays the following message:

2 Sitecore - Webpage Dialog

4 Subscription
ra Subscription confirmation.

fou have subscribed.
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4.5 Linking to CRM

You can also link the Sitecore reports with you CRM system.

If you click on CRM, the message, not yet implemented is displayed in a web page.

jul 10 - jul 17, 2009 Filter Save Filter Design

= print [l save 14 4 page 2fof3 b Ml Q w00%

Sessions

2009-jul-17 11:47:40

ed, spent 00:00

However, the way in which this link works depends on how CRM integration has been implemented on
your website.

For more information about CRM integration, contact your website administrator.
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4.6 Saving and Filtering Reports
There are various ways in which you can improve the relevance of Sitecore reports.
You can:

¢ Change the date range used in a report.

e Save areport.

e Place filters on the report.

e Print a report.

4.6.1 Selecting a Date Range

When you open a report, you can see the date range for the data at the top of the report viewer.

-]L 14 - jul 21, 2009 Filter Save Filter Design

S Frint | save 14 4 Poge[ 1loft b bl Quuoo% [ Whoe

Top Pages

Page Views Page URL
%

¥

1

2. 17 /Our-Services.aspx

3 12 /Our-Process.aspx

4, 11 /en/~/media/Images/Broch
5 11 /Our-Services/~/media/lma,
6.

7.

g8 [sitecore

5 /Our-Clients.aspx

To change the date range of a report:
1. Open a report in Sitecore Analytics.

2. Click the date at the top of the report and a date range filter is displayed.
I 0

jul 14 - jul 21, 2009 Filter Save Filter Design
Date Range
[14-07-2009 | 9 - [21-07-2000 |

S print [ save 4 4 Page[  1]cF1 b Bl Q 100%

3. Inthe Date Range fields, enter a start and end date directly into the date fields or alternatively

click the calendar icons to select a dates.

4. Click Apply to update the report and save your date selection.
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4.6.2

Saving a Report

@ sitecore

In Sitecore Analytics, you can save a report in a number of different formats, such as, Word, Pdf, XML,
Excel, Text file format, and so on. Saving a report in this way is quick and easy.

To save a report:

1. Open Sitecore Analytics.

2. Open a report such as the Top Pages report.

3. Click Save to see the options that are available.

Save Filter Design

4 Poge[_ o1 b Bl Q

jul 14 - jul 21, 2009 Filter
& Print | save 4
T adobe Pdf
T4l Micrasoft Xps
&] Himl

—]
=)

il Mht Web Archive

E Text

# | [fw) RichText Page URL
1. | ¥ Microsoftword 207 /
2. | OpenDocumentW| JOur-Services.aspx
3. (¥ MierosoftExcel /Qur-Process.aspx
4, ) Microsoft Excel X Jen/~/media/Images/Brochure
5. ‘G Bocsibe o JOur-Services/~/media/Images
. Fi OpenDocument C. e

gl csv .
7. @ ohoce JOur-Clients.aspx
3. - /Design-Inspiration/Functional
9 @ &m /Design-Inspiration/Sustainabl
10. @ of JOur-Partners.aspx
n @ Jen/Design-Inspiration.aspx
12, F Pox /Our-Services/Consult.aspx
13. | g Jen/0ur-Pracess/Design-Devel
14. |fE) Tff Jen/News-and-Events.aspx
15. | [G Metafle Jen/Design-Inspiration/Traditic
16. 2 /Our-Services/Design.aspx
17. 2 /Our-Services/Build.aspx

4. Select a file format, for example Microsoft Word 2007.

File Download

7

Do you want to open or save this file?

MName: TopPages_Report.docx

Type: Microsoft Office Word Document, 10,2KB

From: localhost

3

COpen ] [ Save ] [

Cancel

l

While files from the Intemet can be useful, some files can potentially

ham your computer. f you do not trust the source, do not open or

save this file. What's the risk?

Open or save the report.

If you decide to save the report, you can store your report in a local folder.

Follow the same procedure to save the report in any of the other file types.
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4.6.3 Printing a Report

When you view a report in Sitecore, you can print it from the report viewer.

To print a report:

1. In Sitecore Analytics, open a report, such as the Top Pages report.

2. Click Print.

3. Select one of the three available options.

jul 14 - jul 21, 2009 Filter

) Frint to Pdf

T Print with Preview
0.

Sl Print without Preview TO p P age S

Page of 1 B Bl 100%

Save Filter Design

B

Page Views PageURL

0~ g A w BN e

%

17 /Our-Services.aspx
12 /Our-Process.aspx
11 fen/~/media/Imag
11 /fOur-Services/~/m

g [sitecore

6 /Our-Clients.aspx

5 /Design-Inspiratio

Print Option

Description

@ Sitecore

Print to Pdf

Preview the report as a Pdf document in Adobe Reader or
save it as a Pdf file.

Print with Preview

Previews the report in Internet Explorer print format. In
Internet Explorer, click File, Print to print the report.

Print without Preview

Displays the Print dialog box

4. Inthe Print dialog box, click Print.

4.6.4  Filtering a Report

In Sitecore Analytics, you can filter any report to change the data that it contains.

To filter a report:

1. In Sitecore Analytics, open a report, such as the Top Pages report.

In this example, we limit the report so that it only displays information about a single page on the

website.

Right click the existing report and then click Duplicate.

Give the duplicate report a suitable name, for example, Architectural Digest Page.

4. Open the new report.
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5. Inthe new report, click Filter to open the Filters Editor dialog box.

jul 16 - jul 23, 2009 Save Filter

) Print ==

I4

4 Fage|  1]of1

4

Desin

bl Q 100% | &, Whole Report &4 Mail Report

Architectural Digest page

3 sitecore - Webpage Dialog

# Page Views Page [l
1 2 TNaw L Filters Editor
. NI select your fiters first, then specify the values
INe in the description.
= 4 Event]
1, Select the flters:
3. 4 /308 " iere the number of tmes the visitor has visited 23
4 3 INewf | the web site compares to number
[[] where the visitor uses specific ISP
5 3
) uhere specific page was visited
& 3 /20 | 1 here page in specificknguage nas visted =
7 2 /sited | [ pere the lattude o the vistor compares to
SIgNUl | specific value ~
[sited | ¢ | =
& i You.d] . . ",
- 2. Fiter description (click = Underlined vsiue to sdit 1)
9 1 /enfq [ ere the vistor s humen @B
10, N and where specific nage was visited HE
1. 1 Jen/d
12. 1 /our-
13. 1 fsite

2009-07-

re2009.ashx

%

s/AD-

[/ Thank-

@ sitecore

6. Inthe Filters Editor dialog box, in the Select the filters section, select the where specific page

was visited filter.
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7. Inthe Filter description section, click the specific page variable to open the Select Item dialog

box.
A Sitecore — Webpage Dialog E]
Select Item
Select the item to use in this rule.
= & Content &

= &) Home
= () standard-Ttems
=4 Brochures
m Copyright
=] U Landing-Pages

‘Jj Register-Form
. Search-Results
. Statistics
UTeasers
) Toolbox
(@ Our-Process
8 our-services
& our-Clients
€ Our-Partners
\) Design-Inspiration
& News-and-Events =
&3 About-Us
jl Contact-Us
) Meta-Data
i) settings |

8. Inthe Select Item dialog box, navigate to the page that you want to use in the filter.
In this example, we use the Standard-Iltems/Landing-Pages/Architectural-Digest-May08.
9. Select the item and click OK to save your changes.

10. Click Save Filter to save the new filter criteria. Notice that the report only shows the page you
specified in the filter.

jul 16 - jul 23, 2009 Fiter Save Fiter Design

& Print [ save 4 4 :a;;|:|:-'1 PPl Q 100% [, Whole Report [ Mail Report

Architectural Digest page

# Page Views Page URL
1. 4 fad08.aspx

Windows Internet Explorer E‘

lE The fiter has been saved.
.

Note
Administrators can create new filter criteria to expand the selection available in the Filter Editor.
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4.6.5 Filtering a Report to Segment Site Visitors

In Sitecore Analytics, you can create filters to segment site visitors according to geography, profile or any
other criteria. For example, you might want to create a new filter for a specific county segment, such as
Brazil.

Creating a New Filter
To create a new filter:

1. Open the Marketing Center and in the content tree, navigate to Analytics Filter/Report
Filters/Culture.

2. Inthe Insert group, click Predefined Filter.
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Enter the name of the new item:

Brazil ‘
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3. Call the new item Brazil.
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In the Header field of the new item, type “where the visitor is from Brazil”.

In the Filter field, click Assign.
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Select your filters first, then specify the values in the description.
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2. Filter description {dlick an underlined value to editit):
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In the Filter Editor dialog box, select the Where visitor is from a specific country filter.

where the visitor is from spedfic country EE

In the Filter description section, click the specify country variable.
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8. Inthe Enter value dialog box, enter Brazil or BR, which is the country code for Brazil.
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2. Filter description (dick an underlined value to editit):
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9. Click OK to close the Filter Editor and save your changes.

Assigning an Icon to the Filter
1. To assign an icon to your filter, open the filter item.

2. Click the filter icon in the content item to open the Icon dialog box.
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3. Inthe Icon dialog box, open the drop down box and select Flags.
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4. Select the icon for the Brazilian flag and click OK.

Verifying the New Filter

To verify that the new filter as been created:
1. Inthe Sitecore Desktop, click the Sitecore button and then click Sitecore Analytics.
2. In Sitecore Analytics, open a report, such as Top Landing Pages.
3. Click Filter.

In the Filter Editor dialog box, verify that the new “where the visitor is from Brazil” filter is
displayed in the list:
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4. Click OK to close the Filter Editor dialog box.
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